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CHAPTER 1

General Information

1.1 General Information

Thank you for purchasing HousUs! We’re very pleased that you have chosen our plugin to extend your website. We’re
doing our best not to disappoint you! Before you get started, please check out these documentation pages. HousUs
can only be used with WordPress and we assume that you already have it installed and ready to go. If you don’t, please
see WordPress Codex to get started.

1.2 Requirements

Before using HousUs, please meet the following requirements:

• Essentials to run WordPress – Read more about WordPress Minimum Requirements – in case any doubts re-
garding the server, contact your host provider.

• Latest version of WordPress, which you can download here.

• Create secure FTP and Database.

1.3 Installation

In our guide, we will show you step by step instructions on how to install our WordPress theme for beginners. Below
you will find will cover two ways to install a WordPress theme.

1.3.1 Installation via Administration Panel

If HousUs files are downloaded from your Themeforest account, you can start an installation using WordPress admin-
istration panel.

1
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In Wordpress Older Version you can find instructions how to proceed with 4.7.0 and lower versions of WordPress.If
you’re using newer version, follow steps below to install the theme:

• Step 1 - Once you’ve logged in to your administration panel, go to My Sites > Network Admin.

• Step 2 - Then click on Themes > Add New, you will be directed to a page where you can choose available
themes.

• Step 3 - Once directed to the page, on the upper left side of the screen click on Upload Theme button.

• Step 4 - Choose the HousUstheme.zip file from your computer, then click Install Now.

2 Chapter 1. General Information
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• Step 5 - Click on My Sites then go to Appearance > Themes and Activate HousUs.

• Step 6 - After activating HousUs, you will be sent to Theme Installation Instruction steps. By following this
steps you will be asked to install required plugins, activate them, import demo content (required) and install
sample of WPL content.

1.3. Installation 3
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Common Install Error: Are You Sure You Want To Do This?

If you get the following question message when installing HousUstheme.zip file via WordPress, it means
that you have an upload file size limit. Install the theme via FTP or call your hosting company and ask
them to increase the limit.

1.3.2 Installation via FTP

To install Kids WP via FTP, follow steps below:

• Step 1 – Unarchive HousUstheme.zip file

• Step 2 – Access your host web server using FTP client

• Step 3 – Find directory wp-content > themes

• Step 4 – Put folder HousUstheme in directory wp-content > themes

4 Chapter 1. General Information
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Learn more:

• WordPress Codex – FTP clients

1.4 Unyson, Extension, and Plugins

Some functionalities of the HousUs Theme are available because of the plugins we used to create it. Once HousUs is
activated in your WordPress admin panel you should see notification about bundled plugins we recommend to install
– they are included in HousUs package – so you don’t have to do anything more than click install and activate.

1.4.1 Unyson

Unyson is a framework for WordPress that facilitates development of a theme. This framework was created from the
ground up by the team behind ThemeFuse from the desire to empower developers to build outstanding WordPress
themes fast and easy. This documentation is heavily modified by createIT to ensure all custom extensions are well
documented.

This documentation assumes you have a working knowledge of WordPress. If you haven’t, please
start by reading WordPress Documentation.

Minimum Requirements

• WordPress 4.0 or greater

• PHP version 5.2.4 or greater

• MySQL version 5.0 or greater

1.4. Unyson, Extension, and Plugins 5
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Installation

Unyson is part of HousUs plugin that should be activated to be able to use the fully use this theme.

After plugin will be activated you will notice the Unyson entry in the sidebar:

Configure the plugin by going to the Unyson menu and activating the following extensions:

• Backup & Demo Content : This extension lets you create an automated backup schedule, import demo
content or even create a demo content archive for migration purposes.

• SASS Compiler : Compiles SASS files. Remember to activate it when you are going to change theme
colors via Customize.

• Breadcrumbs : Creates a simplified navigation menu for the pages that can be placed anywhere in the
theme. This will make navigating the website much easier.

• Visual Composer : Allows for seamless integration with Visual Composer.

• CT Houses : This extension will add houses post type support.

• CT Portfolio : HousUs Portfolio

• CT Surroundings : This extension will add surroundings post type support.

• CT Testimonials : This extension will add testimonials post type support.

• CT Amenities Menu : This extension will add Amenities Menu post type support.

• CT Footer : This extension will add footer sidebars and options.

• CT Twitter shortcode : This extension will add a twitter shortcode.

License

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU
General Public License is intended to guarantee your freedom to share and change free software. Unyson inherits the
General Public License (GPL) from WordPress.

1.4.2 Extension

On the Unysone page you’ll see a list of available extensions separated in two sections:

Active Extensions - Extensions that should be activate to be able to fully use HousUs WP theme functionality:

• Backup & Demo Content - This extension lets you create an automated backup schedule, import demo content
or even create a demo content archive for migration purposes.

• SASS Compiler - Compiles SASS files

6 Chapter 1. General Information
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• Visual Composer - Allows for seamless integration with Visual Composer

• Breadcrumbs - Creates a simplified navigation menu for the pages that can be placed anywhere in the theme.
This will make navigating the website much easier.

• CT Houses - This extension will add houses post type support.

• CT Portfolio - HousUs Portfolio

• CT Surroundings - This extension will add surroundings post type support.

• CT Testimonials - This extension will add testimonials post type support.

• CT Amenities Menu - This extension will add Amenities Menu post type support.

• CT Footer - This extension will add footer sidebars and options.

• CT Twitter shortcode - This extension will add a twitter shortcode.

Available Extensions - extensions not yet downloaded or activate.

Note: We recommend to not activate any of the extensions that are not part of the list above. They may
not be compatible with the theme and could create unexpected issues.

1.4.3 Plugins

Visual Composer

Simply drag and drop elements to build your page content. We prepared components which will help you determine
main structure of the webpage – easily set up backgrounds, colors and styles for whole sections as well as lots of
various smaller components which you can freely put wherever you want.

Note: As the VC plugin used with HousUs WP Theme is part of a bundle, that mean that theme author
has a license and only he/she can download latest versions of VC and include it in the theme. You as a
theme user may use Visual Composer free of charge while you use the theme that came with VC (because
you have a license for that theme).

1.4. Unyson, Extension, and Plugins 7



HousUs

Learn more:

For more information about Visual Composer, please check articles below:

• How to install Visual Composer

• Visual Composer demo

• Visual Composer documentation

Contact Form 7

Contact forms in HousUs WP are created with the use of Contact Form 7 Plugin. Below you will find information
how to recreate Contact forms used in our theme by adding the correct markup for the Form section of this plugin.

If you never before used this plugin I suggest you to check Getting Started with ContactForm 7.

Common questions:

• How to update the plugin when it was packaged with your theme?

• Purchase Code isn’t working
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Booki

A modern booking plugin for WordPress. This plugin allows you to setup appointments or reservations with time that
adapts to users timezone. You can make payment via PayPal or simply book and pay later.

Learn more:

For more information about Booki:

• Introducing Booki

• Booki Demo

Simple Calendar

Add Google Calendar events to your WordPress site in minutes. Beautiful calendar displays, fully responsive.

1.4. Unyson, Extension, and Plugins 9
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Learn more:

For more information about Simple Calendar:

• Simple Calendar

• Simple Calendar Demo

• Simple Calendar Documentation

1.5 Demo Content

Note: To be able to use theme content installation and backup functionality make sure to activate Backup
& Demo Content Unyson’s extension.

10 Chapter 1. General Information
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The fastest and easiest way to import our demo content is to use Theme Options Demo Content Installer. It will import
all pages and posts, sample slider, widgets, theme options, assigned pages, and more.

1.5.1 Import Demo Content

To import our demo content, please follow the steps below:

• Step 1 – navigate to Tools where after activating the Unyson extension Demo Content Install option will be
available

• Step 2 – choose import option you want to use from available options

• Step 3 - To be able to continue you need to agree to this term.

1.5. Demo Content 11
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• Step 4 – Wait until the content will be installed

Importing can take a few minutes. Please be patient and wait for it to complete. Once it will be loading, you will see
message with indicating progress.

We recommend this approach on a newly installed WordPress. It will replace the content you currently have on your
website. However, we create a backup of your current content in (Tools > Backup). You can restore the backup from
there at any time in the future.

1.6 Support

All of our items comes with free support. Free support is limited to questions regarding the themes features or
problems. We provide premium support for code customisation or third-party plugins.

1.6.1 Free Support

For issues and concern, you can reach us through these support methods:

• E-mail – support@createit.pl

12 Chapter 1. General Information
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• Help Desk – Click here to go to our support website. Just click on the Submit Ticket button and follow instruc-
tions to create a ticket.

• Forum – Comment/Post on the product you have issues/queries in ThemeForest or CodeCanyon websites.

Before You Post in a Forum

We urge you to follow the steps below, before you post a new topic on the forum, to speed up your
request. It’s in everyone’s interest and will benefit in making the entire forum more efficient:

– Step 1 – Always check the Documentation and the Knowledgebase Section. Most questions are
already answered in those areas.

– Step 2 – If your question hasn’t been brought up on the forum, please post a new topic. Always
be as specific as possible. Creating a topic requires entering the live URL to your home page or
page that shows the issue in question. It also has bars for WP and FTP login info, which aren’t
required, however, providing us with your login information can save a lot of time for both of
us. Login credentials are securely stored and accessible only by our support staff.

– Step 3 – We usually answer questions in 24 hours on working days. However, if you don’t get
any answer within 72 hours bump up your question or send us an e-mail.

For all support methods, you will receive confirmations and replies on your queries through e-mail or by tracking your
ticket which you will also get through e-mail. To track your ticket, please click here.

Once we reply to your query, each ticket will be open for 7 days without a reply from you. On the 6th day without a
reply, an e-mail will be sent to notify you of the ticket’s inactivity. To make the ticket active again, you simply need to
reply or follow the steps in the e-mail. If you won’t make the ticket active within 7 days, on the 8th day the ticket will
automatically be closed.

Our support hours: 10:00 AM – 6:00 PM UTC +1 on Monday to Friday.

1.6.2 Premium Support

We can create your website from scratch, redesign it or just extend the current ones. For more information, please take
a look at our website. Typical issues covered by Premium Support:

• Custom CSS

• Support for third party software and plug-ins

• WordPress Installation with Theme configuration

• Server configuration

• Site structure modifications

• Graphic adjustments, etc.

• WordPress general howto’s

1.6. Support 13
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Page

You can use Pages to organize and manage any content on your website. You can create multiple pages on your
website for different types of content or setup onepager with scroll-to-section menu.

2.1 Create New Page

To create a new Page in Sella follow the steps below:

• Step 1 - In Dashboard, navigate to Pages > Add New. You will be directed to a page where you can add details
on the page.

15
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• Step 2 - Add the Title of the page.

• Step 3 - Add content – we recommend you to create page content using Visual Composer or by modifying demo
content.
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• Step 4 - Choose page attributes.

– Parent – If you want to create this page as a subpage.

– Template – You can choose one of defined page templates

– Order – The order of the page.

• Step 5 - After adding all the contents of the page, click on the Publish button.

2.1.1 Create Page Using Visual Composer

When using Visual Composer to add content, you have 2 Editor options, the Backend Editor and Frontend Editor.

2.1. Create New Page 17
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Backend Editor
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Frontend Editor

In adding contents to the page, there are many options to choose from. Some of the options are:

• Elements - You will be able to choose elements that are needed and used on the page.

2.1. Create New Page 19
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• Text Block – This is where you add Text to the page.

• Row – An area where you can add elements.
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2.2 Homepage Setup

If you have added some pages via Pages > Add New you can choose one and set it up as a homepage.

Use Static front page tool in Settings > Reading and choose from the list your homepage. Remember to click Save
changes at the end of editing.

2.2. Homepage Setup 21
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2.3 Create a Onepager

One page site allows you to put all the content on one page, and the menu items will link to each different section of
the page.

Think of it as a full site but all in one page. Please read below for information on how to set this up.

To create a Onepager site using HousUs, follow these steps:

• Step 1 - Navigate to the Pages section of your Dashboard and click Add New.
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• Step 2 - In the new page, use the Backend or Frontend editor to create a Section.

Note: You can also use Rows for this. Each section/row will serve as a section in the page to locate
using the menu.

• Step 3 - Click on the Edit option in every section you create and look for Section ID. The Section ID will serve
as the anchor of the menu. Make sure that the ID is unique to the section.

2.3. Create a Onepager 23
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• Step 4 - Add the contents in the Section. You can add rows with text and elements inside. Click on Publish
button to save.
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You can see in the sample above that each section have different Section IDs.

• Step 5 - Set this page as the front page by navigating to Settings > Reading. Click on A static page option, then
select the page for the onepager then click on the Save Changes button.

2.3. Create a Onepager 25
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• Step 6 - To make the Menu for the onepager, navigate the dashboard to Appearance > Menus. Look for create
a new menu, add the Menu Name then click on the Create Menu button.

• Step 7 - You will see options on what to put inside your new menu. Look for Custom Links in the options. If
you don’t see that option, at the upper-right side of the page you will see Screen Options option, click on that
and you will see options with check boxes. Check the box beside Custom Links.

• Step 8 - Using the Custom Links option, write the section’s Section ID inside the URL textbox and the name
of the link inside the Link Text textbox. Then click on the Add to Menu button. After adding all the navigation
menu, Click on Save Menu to save.
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• Step 9 - Click on the Manage Location tab, change the Top primary menu to the menu that you made for the
onepager. Click on the Save Menu button to save.

You can see the changes on the Front Page of the site.

2.3. Create a Onepager 27
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HousUs Elements

3.1 HousUs Custom Shortcodes

With HousUs comes custom shortcodes for (Visual Composer) VC that are used to show content created in HousUs.

Below you will find short information about this Visual Composer elements:

29
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3.1.1 Boxes

This element will let you add boxes that has images and text inside.
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-General Tab-

• Chose position of boxes - Layout of the boxes.

• Select picture for box with picture - Image to be shown inside one of the boxes.

• Select color for the box with text - Background color of the box where the text is written.

• Title in box with text - Text inside one of the boxes.

• Text in link - Text for the link.

• Select color for text in box - Font color of the link text.

3.1. HousUs Custom Shortcodes 31
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• Link Address - URL for the link.

3.1.2 Button

This theme comes with VC element that give you the option to create buttons that can be used in the theme.
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-Button Tab-

• Button title - The label of the button.

• Button size - Size of the button.

• Button style - Color scheme of the button.

• Button link - URL for the link in the button.

• Button icon - Icon inside the button.

3.1. HousUs Custom Shortcodes 33
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3.1.3 Desk

This element will let you add a set of columns that you can add a shortcode or post inside the column.

-General Tab-

• Number of columns - Number of columns to be shown. The Column tabs depends on the number of
column set.

-Column Tabs-

• Select type of content in column - Type of content inside the column.

34 Chapter 3. HousUs Elements
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• Content for column - The content of the column.

-Button Tab-

• Button title - The label of the button.

• Button size - Size of the button.

• Button style - Color scheme of the button.

• Button link - URL for the link in the button.

• Button icon - Icon inside the button.

3.1.4 Styled Google Maps

This element will let you add a google map with a specific address.

3.1. HousUs Custom Shortcodes 35
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-General Tab-

• Custom map height - Set the height of the map. You can leave it blank for a responsive map.

• Zoom - Percentage of the zoom in the map.

• Map box avatar - image shown inside the map box.

• Header on map box - Title of the map.

• Map offset

• Address - Building, street, and town of the address.
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• City - City and country of the address.

• Open Hours - Hours the establishment is open.

• Telephone number - Establishments telephone number.

• Mail address - E-mail address for the establishment.

3.1.5 Houses Header

The element is a custom header for HousUs.

3.1. HousUs Custom Shortcodes 37
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-Header Tab-

• Header Color - Color scheme of the header: Light, Gray, or Dark

• Header align - Alignment of the title.

• Display text after subtitle - Option to display the subtitle after the title.

• Display button in header - Option to add a button in the header.

• Header level

• Header title - What is written inside the header.
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• Header title font size - Font size of the header’s title.

• Header title custom color - Font color of the title.

• Header subtitle custom title - What is written as the subtitle.

• Header subtitle font size - Font size of the subtitle.

• Header subtitle color - Font color of the subtitle.

• Header top margin - Size of the top margin.

• Header bottom margin - Size of the bottom margin.

3.1.6 Latest posts

This will show the latest posts posted in the blog.
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-General Tab- Title - Title for the posts.

-Filters Tab-

• Limit - Set results limit.

• Skip X elements - Skip a number of elements from the results.

• Order - How the posts order looks.

• Order by - How the posts are ordered.

• Specify post objects - Only selected posts are shown.

• Exclude post objects - None of the selected posts will be displayed.

• Specify terms of category taxonomy - Only show posts under the categories.

• Exclude terms of category taxonomy - None of the posts under the categories are shown.

• Specify post tags - Only show posts with selected tags.

• Keyword search - Show items with certain keyword.
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3.1.7 Houses Popup

This element will let you make a popup for a selected shortcode.
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-Main Tabs-

• Number of columns

• Please enter shortcode - Shortcode that is going to be showed for the popup.

• Select background color - Background color of the popup.

-Button Tab-

• Button title - The label of the button.

• Button size - Size of the button.

• Button style - Color scheme of the button.

• Button icon - Icon inside the button.
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3.1.8 Promo Boxes

This element lets you add promo boxes that can be set to be dynamic.
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-General Tab-

• Autoplay - Option to set the promo boxes to move by itself.

• Dotted slider navigation - Option to use a dotted slider as navigation.

• Display arrows in slider - Option to use an arrow slider as navigation.

• Pause on hover when autoplay is on - Option to pause when hovering if autoplay is checked.

• Adapt height of slider to current slide - Option to make slider adapt to changes of height.

-Content Tab-

• Content - Writing the content of the promo box.

Note: Format in writing the content inside promo box: Title^subtitle Separate each item with : “|”
Sample: 20%^Off on Parties|10%^Off on summer

• Color for box - Color of the promo box.

-Slides Tab-

• Slides to show - Number of slides to show.
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• Slides to show on tablets - Number of slides to show on a tablet platform.

• Slides to show on phones - Number of slides to show on a phone platform.

• Set initial slide - Set the initial slider that moves.

• Vertical slider - Option to make the slider vertical.

3.1.9 Reviews

This element will let you show a rating section in your page.
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-General Tab-

• Header for Reviews - Title of the reviews.

• Display Button after header - Option to display a button in the header of the review.

• Type of content - The type of content inside the reviews.

-Content Tab-

• Text for first block - Title for the first block.

• Number for first block - Value for the first block.

• Sign after first block for example: “%” - Sign the value of the first block will have.

• Text for second block - Title for the second block.

• Number for second block - Value for the second block.

• Sign after second block for example: “%” - Sign the value of the second block will have.

• Text for third block - Title for the third block.

• Number for third block - Value for the third block.

• Sign after third block for example: “%” - Sign the value of the third block will have.

• Icon ratings - Icon for how the ratings are shown.

• Display overall rating - The maximum value of the rating.

• Number of elements - Number of elements to be rated. The element names and values depend on this
value.

• Name for element # rating - Name/Title of the element to be rated.
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• Value for element # rating - Rating value of the element.

3.1.10 Section with pictures

This element will let you have a section that has images and text.
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-Section Tab-

• Select section proportion - How the section is divided.

• Select text side - Which side the text is shown.

• Select section background type - Type of display the background is set.

• Background Image for section - Set the background image.

• Background for mobile devices - Set the background image using mobile devices.

• Additional image for section - Additional image shown in the section.
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-Header Tab-

• Header Color - Color scheme of the header: Light, Gray, or Dark

• Header align - Alignment of the title.

• Display text after subtitle - Option to display the subtitle after the title.

• Display button in header - Option to add a button in the header.

• Header level

• Header title - What is written inside the header.

• Header title font size - Font size of the header’s title.

• Header title custom color - Font color of the title.

• Header subtitle custom title - What is written as the subtitle.

• Header subtitle font size - Font size of the subtitle.

• Header subtitle color - Font color of the subtitle.

• Header top margin - Size of the top margin.

• Header bottom margin - Size of the bottom margin.

3.1.11 Slider

This element lets you add a slider with images that moves by itself.
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-General Tab-

• Autoplay - Option to set the promo boxes to move by itself.

• Dotted slider navigation - Option to use a dotted slider as navigation.

• Display arrows in slider - Option to use an arrow slider as navigation.

• Pause on hover when autoplay is on - Option to pause when hovering if autoplay is checked.

• Adapt height of slider to current slide - Option to make slider adapt to changes of height.

-Images Tab-

• Images to slider - The images shown in the slider.

-Slides Tab-

• Slides to show - Number of slides to show.

• Slides to show on tablets - Number of slides to show on a tablet platform.

• Slides to show on phones - Number of slides to show on a phone platform.

• Set initial slide - Set the initial slider that moves.

• Vertical slider - Option to make the slider vertical.
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3.1.12 Weather

This element lets you add the weather of a specific location inside the page.

• Header for weather - Title for the weather element in the page.
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• Select temperature format - Set the temperature format of the location.

• Select location - You can use the location name or a WOEID of the location.

3.1.13 List with icons

This element lets you add a custom list or a list from the amenities item in Amenities.
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-General Tab-

• Do you want to create custom list or add list from amenities - Choose to create a custom list or list from
amenities.

• Chose type of list - How the list would look.

• No of columns in list - set the number of columns in the list.

-Query Tab-

• Limit - Set results limit.

• Skip X elements - Skip a number of elements from the results.

• Order - How the posts order looks.

• Order by - How the posts are ordered.

• Specify ct-amenities objects - Only selected posts are shown.

• Exclude ct-amenities objects - None of the selected posts will be displayed.

• Specify terms of ct-amenities-taxonomy taxonomy - Only show posts under the categories of amenities.

• Exclude terms of ct-amenities-taxonomy taxonomy - None of the posts under the categories of amenities
are shown.

• Specify post tags - Only show posts with selected tags.

• Keyword search - Show items with certain keyword.
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3.1.14 Gallery Elements

This element lets you add a custom gallery or items in the Gallery.

-General Tab-

• Select source for gallery

-Query Tab-

• Limit - Set results limit.
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• Skip X elements - Skip a number of elements from the results.

• Order - How the posts order looks.

• Order by - How the posts are ordered.

• Specify ct-gallery objects - Only selected posts are shown.

• Exclude ct-gallery objects - None of the selected posts will be displayed.

• Specify terms of ct-gallery-taxonomy taxonomy - Only show posts under the categories of gallery.

• Exclude terms of ct-gallery-taxonomy taxonomy - None of the posts under the categories of gallery are
shown.

• Specify post tags - Only show posts with selected tags.

• Keyword search - Show items with certain keyword.

3.1.15 Houses Listing

This element lets you show the houses items inside Houses.
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• Limit - Set results limit.

• Skip X elements - Skip a number of elements from the results.

• Order - How the posts order looks.

• Order by - How the posts are ordered.

• Specify ct-houses objects - Only selected posts are shown.

• Exclude ct-houses objects - None of the selected posts will be displayed.

• Specify terms of ct-houses-taxonomy taxonomy - Only show posts under the categories of houses.
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• Exclude terms of ct-houses-taxonomy taxonomy - None of the posts under the categories of houses are shown.

• Specify post tags - Only show posts with selected tags.

• Keyword search - Show items with certain keyword.

• Type of houses listing - Set the number of columns to show the houses listing or to make it as a slider.

3.1.16 Surroundings Slider

This element will let you add a surrounding slider in the page.
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-General Tab-

• Select source - The source of the posts: Surroundings post or custom content.

• Select type - How the slider content would look.

• Autoplay - Option to set the promo boxes to move by itself.

• Dotted slider navigation - Option to use a dotted slider as navigation.

• Display arrows in slider - Option to use an arrow slider as navigation.

• Pause on hover when autoplay is on - Option to pause when hovering if autoplay is checked.

• Adapt height of slider to current slide - Option to make slider adapt to changes of height.
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-Slides Tab-

• Slides to show - Number of slides to show.

• Turn on fade - This option will show if the slides to show is set to 1.

• Use center mode - This option will show if the slides to show is set to an odd number other than 1.

• Slides to show on tablets - Number of slides to show on a tablet platform.

• Slides to show on phablets - Number of slides to show on a phablet platform.

• Slides to show on phones - Number of slides to show on a phone platform.

• Set initial slide - Set the initial slider that moves.

-Query Tab-

• Limit - Set results limit.

• Skip X elements - Skip a number of elements from the results.

• Order - How the posts order looks.

• Order by - How the posts are ordered.

• Specify ct-surroundings objects - Only selected posts are shown.

• Exclude ct-surroundings objects - None of the selected posts will be displayed.

• Specify terms of ct-surroundings-taxonomy taxonomy - Only show posts under the categories of gallery.

• Exclude terms of ct-surroundings-taxonomy taxonomy - None of the posts under the categories of
gallery are shown.

• Specify post tags - Only show posts with selected tags.

• Keyword search - Show items with certain keyword.
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3.1.17 Testimonial Slider

This element lets you add testimonials to a page.
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-General Tab-

• Select source - The source of the posts: Testimonial posts or custom content.

• Select type - How the slider content would look.

• Autoplay - Option to set the promo boxes to move by itself.

• Dotted slider navigation - Option to use a dotted slider as navigation.

• Display arrows in slider - Option to use an arrow slider as navigation.

• Pause on hover when autoplay is on - Option to pause when hovering if autoplay is checked.

• Adapt height of slider to current slide - Option to make slider adapt to changes of height.
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-Slides Tab-

• Slides to show - Number of slides to show.

• Turn on fade - This option will show if the slides to show is set to 1.

• Use center mode - This option will show if the slides to show is set to an odd number other than 1.

• Slides to show on tablets - Number of slides to show on a tablet platform.

• Slides to show on phablets - Number of slides to show on a phablet platform.

• Slides to show on phones - Number of slides to show on a phone platform.

• Set initial slide - Set the initial slider that moves.

-Query Tab-

• Limit - Set results limit.

• Skip X elements - Skip a number of elements from the results.

• Order - How the posts order looks.

• Order by - How the posts are ordered.

• Specify ct-testimonials objects - Only selected posts are shown.

• Exclude ct-testimonials objects - None of the selected posts will be displayed.

• Specify terms of ct-testimonials-taxonomy taxonomy - Only show posts under the categories of gallery.

• Exclude terms of ct-testimonials-taxonomy taxonomy - None of the posts under the categories of gallery
are shown.

• Specify post tags - Only show posts with selected tags.

• Keyword search - Show items with certain keyword.
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3.1.18 Twitter

This element lets you show the latest post on a twitter account set on this slider.
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-General Tab-

• Title - Header title of the twitter posts.

• Autoplay - Option to set the promo boxes to move by itself.

• Dotted slider navigation - Option to use a dotted slider as navigation.

• Display arrows in slider - Option to use an arrow slider as navigation.

• Pause on hover when autoplay is on - Option to pause when hovering if autoplay is checked.

• Adapt height of slider to current slide - Option to make slider adapt to changes of height.

-Slides Tab-

• Slides to show - Number of slides to show.

• Turn on fade - This option will show if the slides to show is set to 1.

• Use center mode - This option will show if the slides to show is set to an odd number other than 1.
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• Slides to show on tablets - Number of slides to show on a tablet platform.

• Slides to show on phablets - Number of slides to show on a phablet platform.

• Slides to show on phones - Number of slides to show on a phone platform.

• Set initial slide - Set the initial slider that moves.

• Vertical slider - Option to make the slider vertical.

-Twitter-

• Username - Twitter username

• Customer key

• Customer secret

• Token

• Token secret

• Limit - Limit visible tweets.

• Parse url

• Parse media

• Parse user id?

• Parse hashtag?

• Embed images?

• Size of embeded images?

• Tweet length limit

• Cache results for X seconds - Cache Twitter feeds for better performance.

Note: The information how to generate twitter keys and tokens can be found here.

3.2 HousUs Plugin Elements

Some plugins that are used in Sella generates an element that helps customize the pages on your site. You will see the
plugin elements as follows:
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3.2.1 Contact Form 7

This is the plugin that can add a Contact Forms on a page. To know how to create a contact form, go to the Create
Contact Form tutorial.
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3.2.2 Visual Composer

This element lets you customize your page using a simple drag and drop of elements to build your page content. You
can easily setup the backgrounds, colors, and styles for a whole section as well as lots of various smaller components
which you can freely put wherever you want.

Some of these elements are:
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Single Image

This element will let you add a single image in your page.
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Image Gallery

This element will let you add multiple images in your page.
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Video Player

This element will let you add a video or MP3 file inside your page by adding the link for the video/MP3.
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Blogs Posts

Sella is loaded with options for the blog. It offers many different options for you to present your blog posts, along with
several different blog post layouts. In addition, there are numerous theme options and shortcode options that allow
you to customize how posts are displayed.

4.1 Create New Blog

No matter which method you use to display your blog posts, first thing you need to do is create them.

Sella offers several blog post formats:

Follow the steps below to create a blog post:
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• Step 1 - Navigate to Blog Posts > Add New in the Dashboard.

• Step 2 - Create a title and insert your post content in the editing field. You can use any of our shortcode elements
inside the post. If you want to use some additional fields, choose them from Screen Options at the top of the
screen.

• Step 3 - Add Blog Categories on the right side. Categories are meant for broad grouping of your posts, think
of these as general topics. Categories are hierarchical, so you can add sub-categories. Sub-categories are made
when a Category is added to a Parent Category . To assign it to the post, check the box next to the Category
name.

• Step 4 - To add Tags, write the Tags at the textbox below the Blog Categories. Tags are meant to describe

74 Chapter 4. Blogs Posts

https://createit.support/knowledgebase/what-is-a-shortcode/


HousUs

specific details of your posts. They are the micro-data that you can use to micro-categorize your content. Tags
are not hierarchical. Type the name of the tag in the field, separate multiple tags with commas.

• Step 5 - To add a Single image, click the Featured Image box, select an image and click Set Featured Image.

To add more than one image, use Image Gallery (Visual Composer element) , each image will be a slide in
the gallery slideshow. Gallery can be created by adding images from Media gallery or by adding External
links of the images that will be used.

• Step 6 – To post Video, use Video Player (Visual Composer element) and paste the direct video URL from
Youtube, Vimeo or Dailymotion and more.

• Step 7 – to post Audio, use Video Player (Visual Composer element) and paste the direct audio URL from
Soundcloud, Mixcloud and more.
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• Step 8 – For Quotation, use WordPress Blockquote option (Shift + Alt + Q).

_image/quote.png

• Step 9 – For Links, use WordPress Inser/Edit Link option (Ctrl + K).

_image/link.png

• Step 10 – Create an excerpt – Excerpts are optional hand-crafted summaries of your content that can be used in
your theme. Learn more about manual excerpts.

• Step 11 – Once finished, click Publish to save the post.

You will see all the Blogs created at Blog Posts > All Posts.

4.2 Blog Index Page

The most popular way of displaying blog posts is to setup blog index page. There all of your posts will be displayed
and ordered by publish date.

To set the page as your post page, navigate to Posts page tool in Settings > Reading and choose Blog index page from
the ones you created.
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Note: On Blog index page you will see only your posts, so don’t add any other content to it.

4.3 Blog Category

Categories are meant for broad grouping of your posts, think of these as general topics. Categories are hierarchical,
so you can add sub-categories. Sub-categories are made when a Category is added to a Parent Category.

Adding categories to a blog would make it easier to locate and post on similar topics by category.

4.3.1 Create Blog Category

To create a Category for a blog, follow these steps:

• Step 1 - Navigate your Dashboard to Blog Posts > Categories. You will see the Blog Categories page.
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• Step 2 - In the page, find the Add New Category area. Add All the necessary information.
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– Name - The name of the category.

– Slug - The URL-friendly version of the name. Usually all lowercase.

– Parent Category - If the category is a sub-category, then look for the parent category in the
drop-down box.

– Description - Description of the category.

• Step 3 - Once done filling out the information of the category, click on Add New Category button to save.

4.3.2 Delete Blog Category

To delete a Category, navigate your Dashboard to Blog Posts > Categories.

In the Blog Categories page, you will see all the created category.
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To delete a category, you have two options:

• Single Delete - Hover your mouse pointer on the category that you would like to delete. You will see a Delete
option pop-up. Click on Delete to delete.

• Multiple Delete - To delete multiple categories, click on the box beside the categories you would want to
delete. Then click on the drop-down box for Bulk Actions and choose the Delete option. Click on Apply button
to delete.

4.4 Blog Tags

Tags are meant to describe specific details of your posts. They are the micro-data that you can use to micro-categorize
your content. Tags are not hierarchical.

Adding tags to a blog post would make it easier to relate a post with another post even if the categories are different.

4.4.1 Create Blog Tags

To create a Tag for a blog, follow these steps:

• Step 1 - Navigate your Dashboard to Blog Posts > Tags. You will see the Tags page.
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• Step 2 - In the page, find the Add New Tag area. Add All the necessary information.

– Name - The name of the tag.

– Slug - The URL-friendly version of the name. Usually all lowercase.

– Description - Description of the tag.

• Step 3 - Once done filling out the information of the tag, click on Add New Tag button to save.
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Note: Adding a tag may affect the tags from Gallery, Houses, Surroundings, and Testimonials.

4.4.2 Delete Blog Tags

To delete a tag, navigate your Dashboard to Blog Posts > Tags.

In the Tags page, you will see all the created tags.

To delete a tag, you have two options:

• Single Delete - Hover your mouse pointer on the tag that you would like to delete. You will see a Delete option
pop-up. Click on Delete to delete.

• Multiple Delete - To delete multiple tags, click on the box beside the tags you would want to delete. Then click
on the drop-down box for Bulk Actions and choose the Delete option. Click on Apply button to delete.

Note: Deleting a tag may affect the tags from Gallery, Houses, Surroundings, and Testimonials.
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Amenities

5.1 Create New Amenities

To create a new Amenities item, navigate in WordPress Dashboard to Amenities > Add New.

The Add New Menu Item page will show. Add the details for the Amenities.
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1. Title - Title for the amenities item.

2. Options - Here you can add items inside the amenities.
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• Icon - Icon for the item.

• Icon description - Item description/name.

3. Amenities Categories - Add Amenities Categories on the right side. Categories are meant for broad grouping
of your posts, think of these as general topics. Categories are hierarchical, so you can add sub-categories. Sub-
categories are made when a Category is added to a Parent Category . To assign it to the post, check the box next
to the Category name.

After adding all the details, click on Publish button to save.

5.2 Amenities Category

Categories are meant for broad grouping of your posts, think of these as general topics. Categories are hierarchical,
so you can add sub-categories. Sub-categories are made when a Category is added to a Parent Category.

Adding categories to an amenity would make it easier to locate and post on similar topics by category.

5.2.1 Create Amenities Category

To create a Category for a amenities, follow these steps:

• Step 1 - Navigate your Dashboard to Amenities > Amenities Categories. You will see the Amenities Categories
page.
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• Step 2 - In the page, find the Add New Category area. Add All the necessary information.
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– Name - The name of the category.

– Slug - The URL-friendly version of the name. Usually all lowercase.

– Parent Category - If the category is a sub-category, then look for the parent category in the
drop-down box.

– Description - Description of the category.

• Step 3 - Once done filling out the information of the category, click on Add New Category button to save.

5.2.2 Delete Amenities Category

To delete a Category, navigate your Dashboard to Amenities > Amenities Categories.

In the Amenities Categories page, you will see all the created category.
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To delete a category, you have two options:

• Single Delete - Hover your mouse pointer on the category that you would like to delete. You will see a Delete
option pop-up. Click on Delete to delete.

• Multiple Delete - To delete multiple categories, click on the box beside the categories you would want to
delete. Then click on the drop-down box for Bulk Actions and choose the Delete option. Click on Apply button
to delete.
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Gallery

6.1 Create New Gallery

To create a new Gallery item, navigate in WordPress Dashboard to Gallery > Add New.

The Add New Gallery Item page will show. Add the details for the Gallery.

89



HousUs

1. Title - Title of the gallery.

2. Editor container - You can add descriptions about the gallery on this area.

3. Gallery options - Add the images for the gallery.

4. Tags - Specifically categorize a gallery.

5. Gallery Categories - Group a gallery with other gallery in the same category.

6. Featured Image - The image shown in the pages.

After adding all the details, click on Publish button to save.

6.1.1 Add Gallery to Page

To add a gallery to a page, an element in the Visual Composer is used.
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This is the element that will add a gallery on the page. For more information about this element, go to HousUs Custom
Shortcodes > Gallery Elements.

6.1.2 Delete Gallery

To delete a gallery, navigate your Dashboard to Gallery > Our Gallery

In the Gallery page, you will see all the created gallery.

To delete a gallery, you have two options:

• Single Gallery Delete - Hover your mouse pointer on the gallery that you would like to delete. You will see a
Trash option pop-up. Click on Trash to delete.

• Multiple Gallery Delete - To delete multiple galleries, click on the box beside the gallery you would want to
delete. Then click on the drop-down box for Bulk Actions and choose the Move to Trash option. Click on Apply
button to delete.
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6.2 Gallery Category

Categories are meant for broad grouping of your posts, think of these as general topics. Categories are hierarchical,
so you can add sub-categories. Sub-categories are made when a Category is added to a Parent Category.

Adding categories to a gallery would make it easier to locate and post on similar topics by category.

6.2.1 Create Gallery Category

To create a Category for a gallery, follow these steps:

• Step 1 - Navigate your Dashboard to Gallery > Gallery Categories. You will see the Gallery Categories page.
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• Step 2 - In the page, find the Add New Category area. Add All the necessary information.
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– Name - The name of the category.

– Slug - The URL-friendly version of the name. Usually all lowercase.

– Parent Category - If the category is a sub-category, then look for the parent category in the
drop-down box.

– Description - Description of the category.

• Step 3 - Once done filling out the information of the category, click on Add New Category button to save.

6.2.2 Delete Gallery Category

To delete a Category, navigate your Dashboard to Gallery > Gallery Categories.

In the Gallery Categories page, you will see all the created category.
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To delete a category, you have two options:

• Single Delete - Hover your mouse pointer on the category that you would like to delete. You will see a Delete
option pop-up. Click on Delete to delete.

• Multiple Delete - To delete multiple categories, click on the box beside the categories you would want to
delete. Then click on the drop-down box for Bulk Actions and choose the Delete option. Click on Apply button
to delete.

6.3 Gallery Tags

Tags are meant to describe specific details of your posts. They are the micro-data that you can use to micro-categorize
your content. Tags are not hierarchical.

Adding tags to a gallery post would make it easier to relate a post with another post even if the categories are different.

6.3.1 Create Gallery Tags

To create a Tag for a Gallery, follow these steps:

• Step 1 - Navigate your Dashboard to Gallery > Tags. You will see the Tags page.
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• Step 2 - In the page, find the Add New Tag area. Add All the necessary information.
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– Name - The name of the tag.

– Slug - The URL-friendly version of the name. Usually all lowercase.

– Description - Description of the tag.

• Step 3 - Once done filling out the information of the tag, click on Add New Tag button to save.

Note: Adding a tag may affect the tags from Blogs, Houses, Surroundings, and Testimonials.

6.3.2 Delete Gallery Tags

To delete a tag, navigate your Dashboard to Gallery > Tags.

In the Tags page, you will see all the created tags.

To delete a tag, you have two options:

• Single Delete - Hover your mouse pointer on the tag that you would like to delete. You will see a Delete option
pop-up. Click on Delete to delete.
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• Multiple Delete - To delete multiple tags, click on the box beside the tags you would want to delete. Then click
on the drop-down box for Bulk Actions and choose the Delete option. Click on Apply button to delete.

Note: Deleting a tag may affect the tags from Blogs, Houses, Surroundings, and Testimonials.
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Houses

7.1 Create New Houses

To create a new Houses item, navigate in WordPress Dashboard to Houses > Add New.

You will be sent to the Add New Houses Item page. Add the details that you want for the houses item.
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1. Title - Title of the Houses item.

2. Editor container - You can customize how the Houses item would look in its single page post. Using elements
in the visual composer, you can customize the page.

3. Houses options

• Additional Info - The information you add here serves as a summary of details of the houses item.

• Subtitle

• House main gallery - Images shown in the houses. This will also show in the preview of the houses item.
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• Slider - Option to make the gallery into a slider in the single page of the houses item.

4. Tags - Specifically categorize a houses item.

5. Gallery Categories - Group a houses item with other houses item in the same category.

6. Featured Image - The image shown in the pages.

After adding all the details, click on Publish button to save.

7.1.1 Add Houses to Page

To add houses items to a page, an element in the Visual Composer is used.

This is the element that will add houses items on the page. For more information about this element, go to HousUs
Custom Shortcodes > Houses Listing.

7.1.2 Delete Houses

To delete a Houses item, navigate your Dashboard to Houses > All Houses

In the Houses page, you will see all the created houses item.

To delete a houses item, you have two options:

• Single Houses Delete - Hover your mouse pointer on the houses item that you would like to delete. You will
see a Trash option pop-up. Click on Trash to delete.
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• Multiple Houses Delete - To delete multiple houses item, click on the box beside the houses item you would
want to delete. Then click on the drop-down box for Bulk Actions and choose the Move to Trash option. Click
on Apply button to delete.

7.2 Houses Category

Categories are meant for broad grouping of your posts, think of these as general topics. Categories are hierarchical,
so you can add sub-categories. Sub-categories are made when a Category is added to a Parent Category.

Adding categories to a houses item would make it easier to locate and post on similar topics by category.

7.2.1 Create Houses Category

To create a Category for a house, follow these steps:

• Step 1 - Navigate your Dashboard to Houses > Houses Categories. You will see the Houses Categories page.
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• Step 2 - In the page, find the Add New Category area. Add All the necessary information.
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– Name - The name of the category.

– Slug - The URL-friendly version of the name. Usually all lowercase.

– Parent Category - If the category is a sub-category, then look for the parent category in the
drop-down box.

– Description - Description of the category.

• Step 3 - Once done filling out the information of the category, click on Add New Category button to save.

7.2.2 Delete Houses Category

To delete a Category, navigate your Dashboard to Houses > Houses Categories.

In the Houses Categories page, you will see all the created category.

To delete a category, you have two options:

• Single Delete - Hover your mouse pointer on the category that you would like to delete. You will see a Delete
option pop-up. Click on Delete to delete.
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• Multiple Delete - To delete multiple categories, click on the box beside the categories you would want to
delete. Then click on the drop-down box for Bulk Actions and choose the Delete option. Click on Apply button
to delete.

7.3 Houses Tags

Tags are meant to describe specific details of your posts. They are the micro-data that you can use to micro-categorize
your content. Tags are not hierarchical.

Adding tags to a houses post would make it easier to relate a post with another post even if the categories are different.

7.3.1 Create Houses Tags

To create a Tag for a House, follow these steps:

• Step 1 - Navigate your Dashboard to Houses > Tags. You will see the Tags page.
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• Step 2 - In the page, find the Add New Tag area. Add All the necessary information.

– Name - The name of the tag.

– Slug - The URL-friendly version of the name. Usually all lowercase.

– Description - Description of the tag.

• Step 3 - Once done filling out the information of the tag, click on Add New Tag button to save.

Note: Adding a tag may affect the tags from Blogs, Gallery, Surroundings, and Testimonials.

7.3.2 Delete Houses Tags

To delete a tag, navigate your Dashboard to Houses > Tags.

In the Tags page, you will see all the created tags.

To delete a tag, you have two options:

• Single Delete - Hover your mouse pointer on the tag that you would like to delete. You will see a Delete option
pop-up. Click on Delete to delete.
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• Multiple Delete - To delete multiple tags, click on the box beside the tags you would want to delete. Then click
on the drop-down box for Bulk Actions and choose the Delete option. Click on Apply button to delete.

Note: Deleting a tag may affect the tags from Blogs, Gallery, Surroundings, and Testimonials.
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Surroundings

8.1 Create New Surroundings

To create a new Surroundings item, navigate in WordPress Dashboard to Surroundings > Add New.
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You will be sent to the Add New Surroundings Item page. Add the details that you want for the surroundings.
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1. Title - Title of the Surroundings item.

2. Surroundings options

• Description for Surrounding - A summary of description of the surroundings.

• Display custom button text and link - Option to display a button, if unchecked the link will be shown.

• Button name - Text inside the button.

• Button link - URL for where the button will link to.

3. Tags - Specifically categorize a surroundings.

4. Gallery Categories - Group a surroundings with other surroundings in the same category.

5. Featured Image - The image shown in the pages.
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After adding all the details, click on Publish button to save.

8.1.1 Add Surroundings to Page

To add surroundings to a page, an element in the Visual Composer is used.

This is the element that will add surroundings on the page. For more information about this element, go to HousUs
Custom Shortcodes > Surroundings Slider.

8.1.2 Delete Surroundings

To delete a surroundings, navigate your Dashboard to Surroundings > Our Surroundings

In the surroundings page, you will see all the created surroundings.

To delete a surroundings, you have two options:

• Single Surroundings Delete - Hover your mouse pointer on the surroundings that you would like to delete. You
will see a Trash option pop-up. Click on Trash to delete.

• Multiple Surroundings Delete - To delete multiple surroundings, click on the box beside the surroundings you
would want to delete. Then click on the drop-down box for Bulk Actions and choose the Move to Trash option.
Click on Apply button to delete.
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8.2 Surroundings Category

Categories are meant for broad grouping of your posts, think of these as general topics. Categories are hierarchical,
so you can add sub-categories. Sub-categories are made when a Category is added to a Parent Category.

Adding categories to a surroundings item would make it easier to locate and post on similar topics by category.

8.2.1 Create Surroundings Category

To create a Category for a house, follow these steps:

• Step 1 - Navigate your Dashboard to Surroundings > Surroundings Categories. You will see the Surroundings
Categories page.
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• Step 2 - In the page, find the Add New Category area. Add All the necessary information.

– Name - The name of the category.

– Slug - The URL-friendly version of the name. Usually all lowercase.
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– Parent Category - If the category is a sub-category, then look for the parent category in the
drop-down box.

– Description - Description of the category.

• Step 3 - Once done filling out the information of the category, click on Add New Category button to save.

8.2.2 Delete Surroundings Category

To delete a Category, navigate your Dashboard to Surroundings > Surroundings Categories.

In the Surroundings Categories page, you will see all the created category.

To delete a category, you have two options:

• Single Delete - Hover your mouse pointer on the category that you would like to delete. You will see a Delete
option pop-up. Click on Delete to delete.

• Multiple Delete - To delete multiple categories, click on the box beside the categories you would want to
delete. Then click on the drop-down box for Bulk Actions and choose the Delete option. Click on Apply button
to delete.

8.3 Surroundings Tags

Tags are meant to describe specific details of your posts. They are the micro-data that you can use to micro-categorize
your content. Tags are not hierarchical.

Adding tags to a surroundings post would make it easier to relate a post with another post even if the categories are
different.
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8.3.1 Create Surroundings Tags

To create a Tag for a House, follow these steps:

• Step 1 - Navigate your Dashboard to Surroundings > Tags. You will see the Tags page.

• Step 2 - In the page, find the Add New Tag area. Add All the necessary information.

– Name - The name of the tag.

– Slug - The URL-friendly version of the name. Usually all lowercase.

– Description - Description of the tag.

• Step 3 - Once done filling out the information of the tag, click on Add New Tag button to save.
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Note: Adding a tag may affect the tags from Blogs, Gallery, Houses, and Testimonials.

8.3.2 Delete Surroundings Tags

To delete a tag, navigate your Dashboard to Surroundings > Tags.

In the Tags page, you will see all the created tags.

To delete a tag, you have two options:

• Single Delete - Hover your mouse pointer on the tag that you would like to delete. You will see a Delete option
pop-up. Click on Delete to delete.

• Multiple Delete - To delete multiple tags, click on the box beside the tags you would want to delete. Then click
on the drop-down box for Bulk Actions and choose the Delete option. Click on Apply button to delete.

Note: Deleting a tag may affect the tags from Blogs, Gallery, Houses, and Testimonials.
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Testimonials

9.1 Testimonials

A Testimonial is a statement that testify to someone’s character and qualifications. You can use this statements on your
page to establish confidence.

9.1.1 Create Testimonials

To create a new testimonial, on your Dashboard navigate to Testimonials > Add New.
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The Add New Testimonial page will show. Add the details for the testimonial.
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1. Title - The title of the single testimonial page.

2. Editor container - You can add here the testimonial.

3. Testimonial options

• Author Name - The name of the one who said the testimonial.

• Author Description - Description of the author that will be displayed after the author’s name.

• Testimonial Photo - Author’s photo.
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4. Testimonials Categories - Category of the testimonial.

After adding all the details, click on Publish button to save.

9.1.2 Add Testimonials to Page

To add testimonials to a page, an element in the Visual Composer is used.

This is the element that will add a testimonial on the page. For more information about this element, go to HousUs
Custom Shortcodes > Testimonials Slider.

9.1.3 Delete Testimonials

To delete a Testimonial, navigate your Dashboard to Testimonials > Testimonials

In the Testimonials page, you will see all the created testimonials.

To delete a testimonial, you have two options:

• Single Testimonial Delete - Hover your mouse pointer on the testimonial that you would like to delete. You
will see a Trash option pop-up. Click on Trash to delete.
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• Multiple Testimonials Delete - To delete multiple testimonials, click on the box beside the testimonials you
would want to delete. Then click on the drop-down box for Bulk Actions and choose the Move to Trash option.
Click on Apply button to delete.

9.2 Testimonials Category

Categories are meant for broad grouping of your posts, think of these as general topics. Categories are hierarchical,
so you can add sub-categories. Sub-categories are made when a Category is added to a Parent Category.

Adding categories to a testimonial item would make it easier to locate and post on similar topics by category.

9.2.1 Create Testimonials Category

To create a Category for a testimonial, follow these steps:

• Step 1 - Navigate your Dashboard to Testimonials > Testimonials Categories. You will see the Testimonials
Categories page.
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• Step 2 - In the page, find the Add New Category area. Add All the necessary information.

– Name - The name of the category.

– Slug - The URL-friendly version of the name. Usually all lowercase.
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– Parent Category - If the category is a sub-category, then look for the parent category in the
drop-down box.

– Description - Description of the category.

• Step 3 - Once done filling out the information of the category, click on Add New Category button to save.

9.2.2 Delete Testimonials Category

To delete a Category, navigate your Dashboard to Testimonials > Testimonials Categories.

In the Testimonials Categories page, you will see all the created category.

To delete a category, you have two options:

• Single Delete - Hover your mouse pointer on the category that you would like to delete. You will see a Delete
option pop-up. Click on Delete to delete.

• Multiple Delete - To delete multiple categories, click on the box beside the categories you would want to
delete. Then click on the drop-down box for Bulk Actions and choose the Delete option. Click on Apply button
to delete.

9.3 Testimonials Tags

Tags are meant to describe specific details of your posts. They are the micro-data that you can use to micro-categorize
your content. Tags are not hierarchical.
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Adding tags to a testimonials post would make it easier to relate a post with another post even if the categories are
different.

9.3.1 Create Testimonials Tags

To create a Tag for a Testimonials, follow these steps:

• Step 1 - Navigate your Dashboard to Testimonials > Tags. You will see the Tags page.

• Step 2 - In the page, find the Add New Tag area. Add All the necessary information.
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– Name - The name of the tag.

– Slug - The URL-friendly version of the name. Usually all lowercase.

– Description - Description of the tag.

• Step 3 - Once done filling out the information of the tag, click on Add New Tag button to save.

Note: Adding a tag may affect the tags from Blogs, Gallery, Surroundings, and Houses.

9.3.2 Delete Testimonials Tags

To delete a tag, navigate your Dashboard to Testimonials > Tags.

In the Tags page, you will see all the created tags.

To delete a tag, you have two options:

• Single Delete - Hover your mouse pointer on the tag that you would like to delete. You will see a Delete option
pop-up. Click on Delete to delete.
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• Multiple Delete - To delete multiple tags, click on the box beside the tags you would want to delete. Then click
on the drop-down box for Bulk Actions and choose the Delete option. Click on Apply button to delete.

Note: Deleting a tag may affect the tags from Blogs, Gallery, Surroundings, and Houses.
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Calendars

10.1 Calendars

This is a plug in from Simple Calendar that displays a Google Calendar on a page.

10.1.1 Create Calendar

To create a new calendar, on your Dashboard navigate to Calendars > Add New.
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The Add New Calendar page will show. Add the details for the calendar.
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1. Title - The title of the Calendar page.

2. Calendar Settings

• Events - This is the events settings where you can set the calendars behaviour.

• Appearance - You can customize the calendar in this area.

• Google Calendar - Set the google calendar that you would like to use.
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• Advance - Set the time and date of the calendar.

3. Categories - Category of the calendar.

4. Calendar Shortcode - Shortcode to call the calendar.

After adding all the details, click on Publish button to save.

10.1.2 Calendar Settings

In the settings under calendar, you can use your public Google Calendar by setting it up in the setting.

To get to the calendar’s Settings, navigate to Calendars > Settings.

You will see 3 tabs under settings:

• Event Source - You can add the Google API Key for your public Google Calendar. For instructions
on how to get the API, click here.

• Calendars - Attach a calendar to objects.

• Advanced - set advance setting of the calendar.
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After changes has been done to the settings, click Save Changes to save.

10.1.3 Calendar Tools

In the Tools under Calendar, you will see the details and System Report of the calendar.
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CHAPTER 11

Contact Form

11.1 Create Contact Form

To create a new Contact Form item, navigate in WordPress Dashboard to Contact > Add New.
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The Add New Contact Form page will show. Add the details for the Contact Form.
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1. Title - The title for the Contact Form

2. Form Details - Details and information of the form.

• Form - The codes for the user interface of the form.

• Mail - Set the email template of the form.

• Messages - Message prompt when an action is done with the form.

• Additional Settings - You can add customization code.

After adding all the details, click on Save button to save.

11.2 Create Contact Page

Contact Form Page of Sella is generated by the theme from Contact Form item.

To create an Contact Form Page, follow these steps:

• Step 1 - Create a new page where to add the Contact Form.
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• Step 2 - Add a row element to the page, click the Edit this row option of the row. The Row Settings will pop-up.
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• Step 3 - Change the settings to your preference.

• Step 4 - In the row, to add a title for the page. You have the option to add a Text Block or Section/Header Title
element.

• Step 5 - Add a new row to add the Contact Form item. The Contact Form can be generated by Contact Form 7
of Theme Element.

• Step 6 - The Contact Form 7 Settings will pop-up. Change details as needed.

– Select contact form - The form you want to add to the page.

– Search title - Optional title to search if no form is added.

• Step 7 - You can customize the page by adding other elements to the page.
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• Step 8 - Once you have finished customizing the page, click on the Publish button.
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CHAPTER 12

Booki

Booki is a modern booking plugin for WordPress. This plugin allows you to setup appointments or reservations with
time that adapts to users timezone. You can make payment via PayPal or simply book and pay later.

12.1 Create New Booking Project

To create a booking project, navigate to Booki > Projects.

141



HousUs

You will be directed to the Create, edit, and delete projects page.

As the page name suggests, you can create, edit, and delete projects in this page.
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To create a new project, follow these steps:

Under the Projects tab:

• Step 1 - Choose Create new in the Project’s drop down box.
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• Step 2 - Add the name of your project.

• Step 3 - Fill in the needed information as required for your booking.

Note: Read the descriptions of the information to be guided.

– Booking mode

– Maximum booking days or time slot

– Minimum booking days or time slot

– Calendar mode

– Tag

– Project listing settings

* Description

* Preview Image

– General project settings

* Project status

* New Booking Notification Recipient(s)

* Default step

* Booking wizard mode

* Ban list

* Default date selected

– Booking control label settings

* Booking tab caption

* Custom form fields tab caption

* Attendees tab caption

* Available days field label

* Selected days field label

* Booking time field label

* Optional features heading

* Next button caption

* Back button caption

* Create booking button caption

* From

* To

* Proceed to login label

* Make booking label

* Available seats label

– Optional HTML content
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* Content above booking calendar

* Content below booking calendar

• Step 4 - After all the needed information are added, click the Create button to save.

• Step 5 - Once the project is created, you will see the project short code below the project name.

Note: The short code is used to call the project that you would like to use in a n element
or widget.

• Step 6 - Also, after the project is created, other tabs beside project can now be use to customize your
project.

– Form builder - Create a booking form that allows the user to input information for the
booking.

* Element type

* Label

* Value

* CSS class name

* Column Index

* Row Index

* Validation - Basic constraints
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* Validation - Advance constraints

– Booking period - Specify the days that allows booking.

* Booking date range: Start date & End date

* Minimum notice

* Email reminder

* Seats

* Deposits

* Quantity elements general settings

* Quantity elements

* Days to exclude from list of days in selected season

* Cost

– Optional Lists - Add in the booking form extra billable items option for the user.
These are displayed as checkboxes and are added to the bill.

* Optional Item Name

* Cost

– Optional Cascading Lists -

* Select Cascading List

* Label

* Is required

* Value

* Cost

* Dropdown list items

* Select the parent list

12.2 Delete Booking Project

To delete a project in booki, navigate to Booki > Projects.

You will be directed to the Create, edit and delete projects page.

Choose the project you want to delete at the Project dropdown box. The Project dropdown box have all the available
projects.
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Scroll down and look for the Delete button.

12.3 Add Booking to Page

Adding a booking project to a page have 2 options:

1. Sella Element

2. Directly to the Page

(a) Sella Element

To add the booking project using an element follow these steps:

• Step 1 - In the page that you want to add the booking project, you can use the Houses Popup
element. The Houses Popup Settings will show.
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• Step 2 - Add the booking’s project shortcode for the booking project that you would like to
use.
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• Step 3 - Add the details that you would need then click Save changes.

The result should look like a button that when you click it a popup of the booking project will
show.
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(b) Directly to the Page

To add the booking project directly to the page with it’s shortcode:

On the page you want to add the booking project, create/add a text block.

In the content editor, add the booking project shortcode.
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Click Save changes to save the details.
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The result of adding this short code should look like this:
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CHAPTER 13

Widgets & Menu

13.1 Widgets

Widgets are small blocks of content, which you can find in theme footer or sidebar. They were originally designed
to provide a simple and easy-to-use way of giving design and structure control of the WordPress Theme to the user,
which is now available on WordPress Themes to include the header, footer, and elsewhere in the WordPress design
and structure.
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13.1.1 Sidebars

In HousUs you have access to 7 sidebars that can be customized using available theme widgets.

• Footer 1 column

• Footer 2 column

• Footer 3 column

• Footer 4 column

• Post footer 1 column
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• Blog posts list sidebar

• Blog single post sidebar
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13.1.2 How to Edit Widgets

You can access widget edit screen under Appearance > Widgets panel or via Customize on path Appearance > Cus-
tomise > Widgets. It has three main areas:

• Available Widgets

• Inactive Widgets

• Inactive Sidebars and widget areas

To add a widget to your site, drag and drop the name of the widget you want to use from the Available Widgets section
into one of the sidebar areas on the right-hand side of the window.

After you have added it, the widget will open up or if it doesn’t, you can click on the triangle to open it, and you can
change the order by dragging the widget.

The specific settings needed will depend on what type of widget you are using.

For instance, if it is a text widget, you just need to type in the text (and optionally, HTML code), and save the widget.

13.2 Menus

Menus are a list of commands or options you can customize for you to use in your site.

13.2.1 Menu Setup

To make a simple menu, follow the steps:

• Step 1 - Navigate your Dashboard to Appearance > Menus. The Menus page will show.
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• Step 2 - In the menus page, you can edit a menu or make a new menu. To make a new menu, locate create a
new menu.

• Step 3 - You will be asked to name your menu. After naming the menu, click Create Menu.

• Step 4 - From the right side choose pages, links, or categories that you want to add to your menu and click on
Add to Menu. Once menu items are added, you can reorder or nest them via drag and drop tool. Remember to
click Save Menu when you finish to keep your changes saved.

• Step 5 - You can set a menu as a Top primary menu.
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• Step 6 - After any changes, click on Save Menu button.

13.2.2 Using Menu on Widget

Menus can also be shown on widgets section of Dashboard.

After creating the menu you want to use, go to Appearance > Widgets and set the menu on your site using Custom
Menu widget like in the example below:

Choose the sidebar you want the menu to be added, then click on the Add Widget button.
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Set the menu to the one you want to add, then click the Save button.

You can see the changes on the page where the sidebar is used.
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Customising HousUs

HousUs comes with an advanced customizer, which allows to edit most of the theme’s elements in one place. If you
want to use it, navigate to Appearance > Customize.
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14.1 Site Identity

Here you will have the option to customize your site’s identity or how it can be viewed by people.

• Site Title - The title of the site you created.

• Tagline - The slogan/catchphrase for you site. What people will remember if they see your site.

• Site Icon - The icon used as a browser or app icon. Icons must be square, and at least 512 pixels wide and tall.

Add all the information you like to add, then click on the Save & Publish button.

14.2 Colors

You can pick the color scheme of the site here.
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• Pick the motive color - Pick the main color scheme of the site.

• Pick the accent motive color - Pick the secondary color scheme of the site.

• Pick the background color - Pick a background color for the site.

• Chose background image - Pick a background image.

164 Chapter 14. Customising HousUs



HousUs

14.3 Navigation, Page Header, Preloader, Api

This section is divided into 4:
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14.3.1 Page Header
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• Display page title in header - Option to display the title of the page.

• Display breadcrumbs - Option to display breadcrumbs of the page.

• Head section type - How the header behaves.

– Static

– Parallax

– Video

– Kenburns

• Background image - Background image of the header.

• Second background image - This will only apply for a Kenburns type of header.

• Third background image - This will only apply for a Kenburns type of header.
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• Head height - Height of the header.

• Parallax ratio - This will only apply for a Parallax type of header.

• Video url - This will only apply for a Video type of header.
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14.3.2 Navigation
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• Navigation behavior type

• Badge in navigation - Option to show a badge in the navigation.

• Social share - Option to show social share icons on top of the navigation.

• Custom link displayed in facebook social - Link for facebook social.

• Custom link displayed in twitter social - Link for twitter social.

• Custom link displayed in reddit social - Link for reddit social.

• Custom link displayed in digg social - Link for digg social.

• Custom link displayed in linkedin social - Link for linkedin social.

• Custom link displayed in google-plus social - Link for google-plus social.

• Custom link displayed in pinterest social - Link for pinterest social.

• Custom text displayed in social - Custom text to be displayed in social share.

• Chose custom icon - Icon to be displayed beside the custom text.

14.3.3 Preloader on/off

Option to show preloader before page is loaded.
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14.3.4 Google Api options

14.4 Blog Settings

The blog settings is divided into 2:

• Blog posts list

14.4. Blog Settings 173



HousUs

– Display blog sidebar - Option to display sidebar in blog list page.

– Place to display sidebar - Where the sidebar is placed.

– Select width of sidebar - Width size of the sidebar.

– Post Layout - Layout of the posts.

– Display full posts in post list pages - Option to display the full blog post in the blog list page.
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• Single blog post

– Display blog sidebar - Option to show sidebar on the individual blog’s page.

– Place to display sidebar - Location on the page where the sidebar is placed.

– Select width of sidebar - Width size of the sidebar.

– Tags after post - Option to show blog’s tags after the post.

– Social Share - Option to show the Social Media Share Buttons.

– Author info after post - Option to show author info after the post.

– Social Share - Options of social media to show as Social Media Share Buttons.

– Display comments after post - Option to have a comments area after the post.
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14.5 Pages

14.5.1 Houses

Layout for the houses listing page.

14.6 Footer

You can customize the footer here.
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• Footer display - Option to display footer on the page.

• Number of footer rows - Number of rows in the footer.

• Footer logo - Option to show a logo in the footer.

• Logo Image - The image to show as the logo.

• Post footer display - Option to display a section after the footer on the page.

• Number of post footer rows - Number of rows in the post footer.

14.7 Static Front Page

Option for the front page is shown here.

• Front page displays - Options on how the front page/home page looks like.

– Your latest posts - Show the latest post on your blogs.

– A static page - Set a page that would stay the same until the page is replaced manually.
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Note: You can also do this using the Homepage Setup instructions in Page > Homepage Setup.

14.8 Header Image

You can add/edit the logo that will show in the header of the page.
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You can hide the header icon by clicking the Hide image button or you can add a new icon by clicking the Add new
image button.

14.9 Widgets

You can customize what is inside the widgets on the page. If a widget is placed on the page you see on the preview, it
will be listed on the left side under widgets.

14.9. Widgets 181



HousUs

• Footer 1 column

• Footer 2 column

• Footer 3 column

• Footer 4 column

• Post footer 1 column

Note: You can also do the same thing by following How to Edit Widgets instructions in Widgets & Menu > Widgets.

14.10 Additional CSS

You can add your own CSS code for your site.
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